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This step-by-step guide is designed to accompany the Level up From Tinkercad to Fusion 360: 
Design a helmet practice project four-part video series. Review these instructions to become familiar 
with the suggested steps as you prepare to guide students though completing this project using 
both Tinkercad and Fusion 360. Or, if you’re creating the helmet design on your own, follow the step-
by-step instructions to make your design. 
 
Each section of this guide includes learning objectives, key terminology covered in the videos, and 
instructions with screenshots for your reference. 
 
View the entire four-part series on our Level Up from Tinkercad to Fusion 360 playlist: 
https://bit.ly/3nMmTbQ 
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Step-by-step: Starting a design in Tinkercad (Part 1 of 4) 
 

This portion of the step-by-step guide is designed to 
accompany the Level Up Helmet Project (Part 1 of 4): 

Starting a design in Tinkercad video.  

 
Link to Video 1: 
https://bit.ly/3FQbHRC 
                                                                                                                    
 

    Basic helmet design in Tinkercad 
 

Learning objectives 

After completing the steps outlined in this guide using Tinkercad, you should be able to:  

• Create 3D objects.  
• Connect objects to each other.  
• Measure objects.  
• Review connections between objects.  
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Key terminology  

• Align: A tool in Tinkercad that lets you place or arrange objects in a straight line. To use the 
Align tool, select at least two objects by Shift left-clicking on them or by dragging a box 
around them. Once selected, click on the Align icon at the top. Simply move your mouse over a 
node (the black dots) to preview the move. 

• Computer Aided Design (CAD): A type of computer software that allows you to create multi-
dimensional objects  

• CAD model: A design created in CAD software. Examples of CAD software include Autodesk’s 
Tinkercad and Fusion 360, which allow you to create 3D representations of your ideas 

• Design parameters: Values that are assigned to something you make, like size, weight, and 
materials  

• Duplicate: A tool that lets you make an exact copy of an object. To duplicate an object, use Ctrl 
+ D and then drag it out or use the arrow keys 

• Group: A tool in Tinkercad that lets you combine two or more shapes into a part. Do this by 
selecting them and then choosing the Group icon at the top 

• Hide: A tool that lets you to save the objects and clear the workspace 
• Hole: A tool used to subtract from a solid shape 
• Ruler: Use this tool to display or change the dimensions or distance of a shape or object 
• Viewcube: A cube-shaped tool that lets you rotate your perspective for view specific views, 

including front, side, right, left, top, and bottom 
• Workplane: The large, blue grid where you create your designs in Tinkercad. You can drag 

out new workplanes onto the surfaces of your shapes for easier stacking and more precise 
measuring 
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Step-by-step instructions 

 
  

1. Open a new Tinkercad file. Start your design by 
creating the base of the cap, which is a simple dome-
like shape. Select a Half Sphere from the Basic Shapes 
Toolbar.  

  
 
  

2. Modify the Half Sphere into an oval shape on the 
workplace using these dimensions. To switch the type 
of unit you want to use, click Edit Grid and then either 
Millimeters or Inches from the dropdown menu.  
• Width: 152.4 mm or 6 inches 
• Length: 177.8 mm or 7 inches 
• Height: 50.8mm or 2 inches 

  

3. Duplicate the shape by selecting it and then selecting 
the Duplicate button, or by holding down the CTRL + D 
keys.  
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4. Make sure you select the shape, and then change the 
duplicate shape into a hole by selecting the Hole 
button in the Shape Toolbar. Then change the Hole 
Shape dimensions:  
• Width: 146 mm or 5.75 inches 
• Length: 171.5 mm or 6.75 inches 
• Height: 44.5 mm or 1.75 inches 

 
  

   
5. Next, select both shapes and use the Align tool to 

overlap both shapes, with the hole shape inside the 
solid shape.  
  

  
  

6. Select both shapes and use Group tool, or hold down 
the CTRL + Shift + G keys, to create a hollowed single 
shape. Then select the new shape and use the 
Duplicate tool to create two.  
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7. Now, drag a Box shape onto the workplane and change 
its dimensions:  

• Width: 25.4 mm or 1 inch 
• Length: 177.8 mm or 7 inches 
• Height: 76.2 mm or 3 inches 

 
 

 
 

 
8. Turn the box into a hole by selecting the Hole button 

in the Shape toolbar.   

 

  

9. Select both shapes and use the Align tool to overlap. 
The hole should run down the center of the oval shape.  
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10. Next, select the shape with the hole running through it 
and modify its dimensions:  
• Width: 158.8 mm or 6.25 inches 
• Length: 184.2 mm or 7.25 inches 
• Height: 44.5 mm or 1.75 inches 

 
  

 

 

11. Now change the other duplicated shape’s dimensions, 
and then select Hide to clear the workspace from view.  
• Width: 152.4 mm or 6 inches 
• Length: 177.8 mm or 7 inches 
• Height: 44.5 mm or 1.75 inches 

 
 

 
  
 

12. To get started on the next component of the model, 
drag a Cylinder shape to the workplane, and modify its 
dimensions:  

  
• Width: 152.4 mm or 6 inches 
• Length: 177.8 mm or 7 inches 
• Height: 127.0 mm or 5 inches 
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13. Duplicate the shape to create two shapes, and turn one 
of the shapes into a hole. Then modify the hole shape’s 
dimensions:  
 
• Width: 149.9 mm or 5.9 inches 
• Length: 175.3 mm or 6.9 inches 
• Height: 127 mm or 5 inches 

 
  

14. Select both shapes, use the Align tool to overlap then, 
and then select Group. The cylinder is now hollow.  

 

  

15. Next, drag a box to the workplane, and modify its 
dimensions:  
  
• Width: 127 mm or 5 inches 
• Length: 50.8 mm or 2 inches 
• Height: 127 mm or 5 inches 
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16. Convert the shape into a hole with the Hole tool.  

  

17. Now overlap the rectangular box-shaped hole into the 
hollowed cylinder in a way that creates an opening 
widthwise across the cylinder. To do this, select both 
shapes and use the Group tool to merge them. Then 
select Hide to save the objects and clear the 
workspace.  

  

 

18. Now that the base is complete, start the visor by 
dragging a Roof shape to workplane, and then rotate it 
90 degrees so it’s facing upward. Rotate it once more 
45 degrees counterclockwise.  
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19. Modify the dimensions of the roof shape:  
  
• Width: 76.2 mm or 3 inches 
• Length: 76.2 mm or 3 inches 
• Height: 76.2 mm or 3 inches 

 
 
 

 
 

20. Duplicate the shape to create two, and then select one 
of the roof shapes and use the Hole tool to turn it into a 
hole.  

  

21. Change the dimensions:  
 
• Width: 71.1 mm or 2.8 inches 
• Length: 71.1 mm or 2.8 inches 
• Height: 88.9 mm or 3.5 inches 
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22. Select both shapes. Use the Align tool to overlap both 
shapes and the Group tool to group them together.  

 

  

23. Duplicate the shape to create three identical shapes. 
Then select the first duplicate and change its 
dimensions.  
  
• Width: 88.9 mm or 3.5 inches 
• Length: 88.9 mm or 3.5 inches 
• Height: 76.2 mm or 3 inches 

 

24. Rotate the shape 45 degrees counterclockwise.   
 
 

25. The next step is to select the second duplicate and 
change its dimensions. Then rotate this shape 
counterclockwise like the other shapes. 
  
• Width: 76.2 mm or 3 inches 
• Length: 76.2 mm or 3 inches 
• Height: 50.8 mm or 2 inches 
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26. Repeat this process with the third duplicate on the 

workplane, using these dimensions. Then, hide the 
objects and clear the workspace once more. 

  
• Width: 82.6 mm or 3.25 inches 
• Length: 82.6 mm or 3.25 inches 
• Height: 12.7 mm or 0.50 inch 

  

 

27. For the final component, you’ll create a screw to hold 
the visor on the helmet. To start, drag a Cylinder to the 
workplane and change its dimensions:  

  
• Width: 25.4 mm or 1 inch 
• Length: 25.4 mm or 1 inch 
• Height: 12.7 mm or 0.50 inch 

 
 

28. Duplicate the shape to create three cylinders, and 
change one of the shapes to these dimensions:  
  
• Width: 20.32 mm or 0.80 inch 
• Length: 20.32 mm or 0.80 inch 
• Height: 6.35 mm or 0.25 inch 
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29.  Next, modify another one of the cylinders into the 
following measurements:  
  
• Width: 12.70 mm or 0.50 inch 
• Length: 12.70 mm or 0.50 inch 
• Height: 15.2 mm or 0.60 inch 

 

  

30. Now select both previously modified shapes and align 
and group them. See how it looks like a bolt screw?  

 

  

31. Now that you have all the parts designed, it’s time to 
assemble. To start, select Hide to reveal the previous 
components for final assembly.  

  

32. Use the ViewCube to make sure your components are 
touching each other so that no components end up 
floating in space.  

 
 



 
 
 

Level up from Tinkercad to Fusion 360: Design a helmet      Page |   15 

 
33. Use the Ruler tool to ensure your components are 

exactly where you want them to be, and then measure. 
Place the Ruler at the edge of the helmet base.  

 

  

34. To change the type of measurement you want, like the 
distance from one object endpoint to another, click the 
circle at the corner of the ruler.  

 

  

35. Feel free to make tweaks to your design, like color edits. 
Now you have a basic model!  
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Step-by-step: Sending a design from Tinkercad to Fusion 360 (Part 2 of 4) 
 
   
This portion of the step-by-step guide is designed to 
accompany the Level Up Helmet Project (Part 2 of 4): Sending 
a design from Tinkercad to Fusion 360 video.  
 
Link to Video 2: 
https://bit.ly/33CzgAo  

  

                                                                                                   

                                                                                                          Basic helmet design in Fusion 360 

 
Learning objectives 

After completing the steps outlined in this guide, you should be able to use Tinkercad and 
Fusion 360 to: 

• Send a CAD model from Tinkercad to Fusion 360. 
• Open an exported file in Fusion 360. 
• Navigate the basic features of the Fusion 360 interface. 
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Key terminology  

• Assembly: Composed of one or more components 
• Body: A continuous 3D object; the Bodies dropdown menu is listed under each component 
• Browser: The area where any objects in a CAD model or assembly are listed, which lets you 

keep track and control objects in an assembly 
• Component: Composed of one or more bodies 
• Data Panel: The area that shows your data or hides your data if it’s overwhelming the 

workspace  
• My Profile: The area where you can view your account and sign out 
• Send to Fusion 360: After selecting all the parts of a design, this button lets you prepare your 

model to open in Autodesk’s Fusion 360 
• Timeline: Allows you to keep track of each step you’ve completed in your design process by 

showing all operations performed in order. If sending a design to Fusion 360, the “Capture 
Design History” option must be chosen 

• Toolbar: Organizes a wide variety of tools available in Fusion 360 
• Workspace Picker: The area that allows you to choose the appropriate workspace in Fusion 

360 
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Step-by-step instructions 

 
  

1. Prepare to export your Tinkercad file by making sure all 
parts are selected. 

  
 

 
  

2. Select the Send to Fusion 360 button at the top right of 
the screen. Your file is then ready to open in Fusion 360. 

 
 
 
 
 

  
  
 

3. Take some time to navigate the new design environment 
in Fusion 360. Select the Data Panel to review your data. 
You can also use this tool to hide your data if it’s 
overwhelming your workspace.  
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4. Next, navigate to the Application Bar. Similar to word 

processing software, here you’ll find the File menu as 
well as Save and Undo/Redo function.  
  

  
  

 

5. The New Design button lets you create a new design.  

  

 
 

  
 

6. You can view your account and sign out in the My 
Profile area, similar to Tinkercad.  
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7. Now, take a few moments to explore the Toolbar. In 
contract with Tinkercad, where all your tools fit on a 
single toolbar above your workspace, Fusion 360 has an 
enormous number of tools. Just as it’s easier to find a 
tool like a spatula in a kitchen workspace than a garage 
workspace, Fusion 360 offers various Workspaces to 
make it easier to organize your work. You can switch 
your workspace using the Workspace Picker. 

 
 

8. Take some time to explore the Browser. This is where 
any objects in your CAD model or assembly will be 
listed. It lets you keep track of as well as control 
objects in your assembly. 
 

9. Anything that moves independently in your design 
should be its own Component. For example, in the 
helmet design, your assembly is your helmet, which is 
composed of a top cap, face guard, mount, etc. In turn, 
each component is made up of one or more bodies or 
continuous 3D objects you created in Tinkercad. 
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10. If you look you at the Browser, you’ll see why it’s 
important to know the difference. When you imported 
your helmet CAD model, several components were 
already created. The top-level file is the assembly 
containing all the components. You’ll also notice the 
Bodies drop-down menu under each component. This 
area lists any bodies associated with a particular 
component or assembly. 

 
 

11. Now turn your attention to the Timeline, which allows 
you to keep track of each step you’ve done in the 
design process. Any operation performed on your 
design will be listed here in order. 
 
Now that you can navigate your way around Fusion 
360, next you can start bringing your helmet design to 
life! 
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Step-by-step: Modifying a Design in Fusion 360 (Part 3 of 4) 
   

This portion of the step-by-step guide is designed to 
accompany the Level Up Helmet Project (Part 3 of 4): 
Modifying a design from Tinkercad to Fusion 360 video.  
 
Link to Video 3: 
https://bit.ly/3qR9AsR 

  

                     

Modify a helmet design in Fusion 360 
 
Learning objectives 

After completing the steps outlined in this guide, you should be able to use Fusion 360 to: 
• Enhance or refine a basic design created in Tinkercad. 
• Round Tinkercad’s hard edges by adding fillets. 
• Emphasize the smoothness of shapes in Fusion 360. 
• Bevel edges by adding chamfers. 
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Key terminology 

• Canvas: The area where you design your project, similar to the workplace in Tinkercad 
• Chamfer: A command that removes material from a sharp object to create a blunt edge or 

bevel 
• Extrude: A command that lets you transform a sketch or a face by adding depth, including 

creating a new solid body, joining to an existing body, removing material from an existing 
body, or creating a new component 

• Fillet: A command that lets you round the edges of a solid body 
• Home: The button that lets you return to your default view 
• Modify: A menu that offers a variety of options for changing your design, including Press Pull, 

Fillet, Chamfer, Shell, etc. 
• Press Pull: A command that lets you change the size or geometry of faces, bodies, and edges 
• Sketch: A 2D blueprint that outlines the overall shape and finer details of the features you 

want to create in your design 
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Step-by-step instructions 

 
 
1. Click the front face of the ViewCube in the upper-left 

corner of the Canvas, which is what we call the 
Workplane in Tinkercad. The front of the helmet 
should face you. To orbit the CAD model in your 
canvas, left-click and drag the ViewCube.  

  
2. For more precise controls, click the corners of the 

ViewCube to rotate the camera and see some 
isometric views. To return to your default view, click 
Home. 
 

 

3. At the top of your helmet design you’ll notice there are 
two halves of an oval. Since you imported the 
components of your CAD model from Tinkercad, you 
can use the Modify drop-down menu to change your 
design. To make your first modification, select 
Chamfer from the Modify drop-down menu.  
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4. The Chamfer command removes materials from the 

object to create a blunt edge or bevel on the edges of a 
sharp object. To do this, select the outer inside edge of 
one of the half ovals on the top of the helmet, and 
then select Chamfer. 
 
  

 
 
   

5. Now you’ll see the Chamfer dialog box. Here, select 
Equal Distance as the Chamfer Type. Modify the Corner 
Type setting to Chamfer to have the newly beveled 
edges meet at the corner. Keep the other options at 
the default settings, except corner types, which you’ll 
modify to Chamfer to have your newly beveled edges 
meet at the corner. Modify the distance of the selected 
edge by 5.08 millimeters, or .2 inch. Then select OK. 
The first edge is now chamfered. 

6. Select both of the upper outer edges of the shape that 
curves around the top of the helmet. Once you select 
one, hold the Shift key and the similar bottom edge on 
the opposite side to select multiple objects at once. 
Next, re-select the Chamfer command from the Modify 
menu. In the Chamfer dialogue, modify the selected 
edges by 2.54 millimeters, or a tenth of an inch. Repeat 
this process elsewhere on your helmet, as needed.  
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7. Reorient the helmet by clicking the bottom front face 
of the ViewCube in the upper-left corner. The front of 
the helmet should face you for this next step. 

  

8. Look for the bottom edge along the thickness of the 
visor forming the cylindrical base of the model on both 
sides. After selecting one, hold the Shift key and find 
the similar bottom edge on the opposite side. This lets 
you select multiple objects at once. 

  
 

 

9. Now you can modify the edges by using the Press Pull 
command from the Modify menu, which lets you 
change the size or geometry of faces, bodies, and 
edges. 

 
 

 
  
 
 

10. Because you selected the edges, the Press Pull 
command automatically routes you to the Fillet 
command. This allows you to round the edges of a solid 
body. In the dialogue box, insert a fillet radius of 11.43 
millimeters, or .45 inch on the selected edges.  
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11. Reposition the ViewCube to the bottom face so that 
you see a view of the interior of your model, including 
the transparent lens component. 

 
 
 
 
 

  

12. Next, use the Fillet command to add additional 
rounded edges. In the dialog, select the edge along the 
width of the lens. Then hold the Shift key while 
selecting the edge on the opposite side. 

  

13. Select the Modify menu and choose the Fillet 
command in the dialog. Modify the Radius type to 
Constant to choose a consistent edge. Then, round 
this up by modifying selected edges by a radius length 
of 25.4 millimeters, or 1 inch. Close the dialog by 
clicking OK. 
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14. Now that you’ve used the Chamfer and Fillet 

commands, explore some other features of Fusion 360 
to refine your design. To add new features to your face 
guard, first activate the Face Guard Component by 
selecting it in the canvas or selecting the component 
in the Browser.  

 
 
 
 

15. Now it’s time to create a Sketch, which is a 2D blueprint 
that outlines the overall shape and finer details of the 
features you want to include. Every sketch requires a 
2D face or plane to draw on. Click the Create panel and 
select the Create Sketch command. 

  

 

16. Select the Line command under the Create menu and 
sketch a shape of your choosing by connecting various 
lines. Use the Line command to create various 
rectangular shapes. When you’re done, click the Finish 
Sketch button. 
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17. Repeat the process on the opposite side of the visor. 
To locate your recent sketches, look in your Browser. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

18. Now that you’ve completed your sketches, it’s time to 
extrude them so you can transform your sketches or 
faces by adding depth. The Extrude command can be 
used to create a new solid body, join to an existing 
body, remove material from an existing body, or create 
a new component. Start by selecting one of the 
sketches you created. 

 
 
 

19. Click Create Menu and select the Extrude command. 
When the dialog appears, select Entire Area as Extrude 
Type.  
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20. Next, select Start as Profile Plane, which means the 
extrusion will start from the face or the profile plane 
you’ve selected.  

 

 

 

  

21.  Now select the Direction as One Side. Then modify the 
Distance or depth of the extrusion as 25.4 millimeters, 
or 1 inch. 

 

  

22. There are a few Operations you can perform in the 
Extrude dialog. Join lets you combine the new shape 
you’re creating with an existing body, like your face 
guard. Cut lets you cut an area out of an existing body 
based on the new body. Let’s choose Cut here. Select 
OK to exit out of the Extrude dialog. The process 
repeates for the remaining sketches on the face 
guard. Let’s move on to the helmet mount. 
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23. Use the ViewCube to orient the helmet so you can see 
the bottom face of the helmet mount. Then activate 
the helmet mount by selecting it in the canvas or 
selecting the component in the Browser. It should 
overlap the cylindrical base. 

24. Now click the Modify menu and select the Split Body 
command. In the dialog, select the outer face of the 
helmet’s cylindrical base as the Splitting Tool. Then 
deselect Extend Splitting Tool and choose OK. 

 
 
 
 
 
 
 
 
 

25. Next, delete the remaining parts you cut using the 
Splitting Tool. Now you have a complete Fusion 360 
model! 
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26. If there’s something you’d like to change in your 
design, you can use Fusion 360’s “CAD time 
machine,” otherwise known as the Timeline, in the 
lower-left corner.  

 
 
 
 

27. The timeline lets you scroll past your assembly 
timeline. You can see every command, including the 
Chamfer command, you’ve completed so far. You can 
make edits as needed by right-clicking the Chamfer 
command, which opens the dialog. Adjust the 
Chamfer distance from 5.08 millimeters to 6.35 
millimeters. 

 
 

 
28.  Next, When your edits are complete, you can click 

Play on the Timeline to see how each command has 
elevated your original design from Tinkercad. 

 
 
 

 

 



 
 
 

Level up from Tinkercad to Fusion 360: Design a helmet      Page |   33 

Step-by-step: Rendering a Design in Fusion 360 (Part 4 of 4) 
Exercise duration: 30 minutes    

 
This portion of the step-by-step guide is designed to 
accompany the Level Up Helmet Project (Part 4 of 4): 
Rendering a design in Fusion 360 video. 
 
Link to Video 4: 
https://bit.ly/3tKqXNK 
.  

                     
                                                                                                         Render a helmet design in Fusion 360 
 
Learning objectives 

After completing the steps outlined in this guide, you should be able to use Fusion 360 to: 
• Modify appearances for a design. 
• Add environments to a render. 
• Create a cloud render. 
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Key terminology  

• Appearance: A tool that lets you change the material used on a body or face, including 
transparent plastic, metal, wood, and more. 

• Decal: A tool that lets you apply a simple image on a component or body, such as a logo or text 
• Cloud rendering: Uses the internet to produce high-quality images of a canvas 
• Render Workspace: The workspace that allows you to create high-quality, photo-realistic 

images that can be used to showcase a design  
• Render: A tool that lets you create photo-realistic images of a design 
• Rendering Gallery: An area that displays thumbnails of your in-progress and complete cloud 

renderings 
• Scene Settings: A tool that lets you change the lighting of a design or the environment where 

you set your design 
• Texture: A tool that lets you add photo-realistic details to the appearance of design 

  



 
 
 

Level up from Tinkercad to Fusion 360: Design a helmet      Page |   35 

Step-by-step instructions 

 
1. In the upper-left corner of the window, use the 

Workspace Picker to transition to the Render 
Workspace, where you can create high-quality images 
to communicate your ideas. 

  
2. In the Set Up panel, choose Appearance. 

 

 

 

3. There are two main methods to add materials to 
bodies and faces from the Appearance dialog. The first 
step of the first method is to select the surface/face of 
a body you want to modify. 
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4. Next, select a material from the Library and drag it 
from the Appearance dialog. (Note: This method only 
applies the selected material and finish to the pre-
selected face.) 
 
  

 
 

   
5. The second method to add materials to components 

and bodies is to highlight the body you wish to modify 
in the Browser. Then select and drag a material from 
the In This Design area in the Appearance dialog to 
the highlighted compnent or body in the Browser. This 
method applies the selected material and finish to the 
entire body, and not just the face. 
 
 
 

6. Choose the following materials for the In This Design 
folder within the Appearance dialog: 

• Leather  
• Aluminum – Polished (Metal) 
• ABS (white) 
• Plastic – Glossy (black) 
• Walnut  
• Acrylic (clear)  
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7. Use the first method on the outer-curved surface of 
the helmet’s top cap to apply the Leather material. 

  

8. Use the second method on both halves of the split 
top to apply the Aluminum material. 

  
 

 

 

 

9. Use the second method once more on both halves of 
the split top cap to apply another material, this time 
from the plastic family: ABS (white). 

 
 

 
  
 
 
 

10. Now, using the first method on both tops of the outer 
curve of the helmet’s top cap split, apply the Plastic – 
Glossy (black) material.  
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11. Then on both lower-bottom curves of the top cap 
split, apply the Leather material. 

 
 
 
 
 

  

12. On the cylindrical base, apply ABS (white). 

 

  

13. On the outline face of the cylindrical base, apply 
the Plastic – Glossy (black) material. 

 
 

 
 
 
 
 

14. Now on the inside face of the cylindrical base, 
apply Leather. And voila, most of your helmet is 
now complete!  
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15. Add some finishing touches now. Add the Walnut 
material to the face guard and the bolts of the 
helmet mount. 

  

 

 

16. Select Clear Acrylic on the transparent lens in the 
helmet’s viewport. 

 

  

17. You can change the color of a few materials now 
using the In This Design folder. Change the ABS 
(Plastic) components that were white by default. 
First, select the Appearance from the Setup panel. 
Hover over the ABS (White) material, right-click and 
select Edit, and then select Color Libraries in the 
pop-up window. 
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18. In the search bar, type in Orange. This will apply the 
selected orange hue onto all the previously white 
ABS materials. If you’d like, repeat this process with 
the other materials in In This Design to customize 
your design. 

 
 
 
 
 

19. Now that you’re render is complete, it’s time to set 
your scene! To begin, select Scene Settings from the 
Set Up panel. A Scene Settings dialog appears, 
showcasing various options between two tabs: 
Settings and Environment Library. 

  

20. In the Settings tab, under Environment, select 
Background and change the setting from Solid Color 
to Environment. This change allows you to see the 
environment in the background of your model in the 
Fusion 360 render workspace. 
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21.  Now move back to the Environment Library tab and 
select Desert or Dry lake bed as the environment. 
(Note that you may have to download an 
environment if it’s not part of the pre-downloaded 
environments in Fusion 360.)  

22. Now it’s time to transform your canvas into a 
photorealistic image. The way you position and light 
your scene is how it will appear in your render. 
Therefore, you need to set up your canvas for the 
ideal render. In the Navigation Bar at the bottom of 
the canvas, use the Rotate command to transform 
your model into its desired position, as well as the 
Zoom command to zoom in and out as desired.  
 
 

23. Once your model is in the desired position in the 
scene, you can render your canvas through two 
methods: in-canvas rendering and cloud rendering. 
In-canvas rendering is the fastest way to create a 
photorealistic image of a design. And cloud 
rendering uses the Internet to product high-quality 
images of your canvas. Go ahead and select the 
Render command from the Redner toolbar in the 
upper-left side of the window. 
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24. A Render Settings dialog will appear. Review the 
settings, make any necessary adjustments, and 
then click Render. 

 
 
 
 
 
 
 

25. It might take a while for the render to complete. 
You can monitor the rendering process via the 
Rendering Gallery, in the lower-left corner, which 
shows you thumbnails of the in-progress and 
complete cloud renderings. To view your full-size 
renders, just click a thumbnail and download as 
desired. 

  
  

26. It’s a good idea to create some additional renders 
with unique scenes and appearances to show off 
your design.  

 
 
 
 
 
 

27. The timeline lets you scroll past your assembly 
timeline. You can see every command, including the 
Chamfer command, you’ve completed so far. You 
can make edits as needed by right-clicking the 
Chamfer command, which opens the dialog. Adjust 
the Chamfer distance from 5.08 millimeters to 6.35 
millimeters. 
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28.  Next, When your edits are complete, you can click 
Play on the Timeline to see how each command has 
elevated your original design from Tinkercad. 

 
 
 

 

 

 


